
                                  CCA- 101: Fundamentals of IT & Programming 

                                                                  Assignment-1 

 

 

 Q2: Discuss about the classification of computers based on size and capacity. 

     Ans: Based on size and capacity, computers are classified as 

1) Super computers: They have thousands of processors. Because of their extraordinary speed, 

accuracy and processing power, supercomputers are well suited for solving highly complex 

problems and huge amount of calculations. 

      e.g. JAGUAR, ROADRUNNER etc.  

          2)    Mainframe computers: They are very large often filling an entire room and can process 

                 thousands of millions of instructions per second. They are capable of supporting hundreds to 

                 thousands of users simultaneously. Functions performed by mainframes include flight 

                 scheduling, reservations and ticketing for an airline etc. 

          3)    Minicomputers: They are much smaller than mainframes. They are typically larger, more 

powerful and more expensive than desktop computers. Users connect to the server through a 

network by using desktop computers. 

      e.g. apple I pod, CDC 160A. 

           4)   Microcomputers: They are the most frequently used types of computers. It is also known as 

                 personal computers. 

                       e.g. desktop computers, laptop. 

 

  Q3: What is the meaning of computer generation? How many Computer Generations are defined?  

What technologies were/are used?  

    Ans: Generation in computer terminology is a change in technology of a computer which were being 

              used. 

              There are four computer generation such as 1st generation, 2ndgeneration, 3rd generation and 4th 

                       generation. 

               In the first computer system, Vaccum tubes were used. 

               Transistors are used in the second generation. 

               Integrated circuit technology was used in the third generation. 

               In the fourth generation microprocessors are used. 

 

Q4: Difference between Volatile & Non- Volatile memories. 



Ans:           volatile memory                                                               non-volatile memory      

 

 

 

 

 

 

 

Q5: Distinguished among system software, application software and open source software on the basis 

of their features. 

Ans: System software: It is a type of software that is designed to run a computer’s hardware and              

application programs. Software like operating systems, compilers, editors and drivers etc. come             

under this category. A computer cannot function with the presence of system software. 

 

            Application software: It is a software created for specific purpose used by end users. It can be          

            called an application or simply an app. 

                 E.g. word processors, accounting app etc. 

 

            Open source software: It is a type of computer software in which source code is released under a            

license in which the copyright holder grants users rights to study, change and distribute the    software 

to anyone and for any purpose. 

                E.g. the Linux operating system.  

Q6a): Create a file in MS-Word to insert a paragraph about yourself and save it with file name 

“yourself”. Describe all steps involved in it. 

 Ans. “Yourself” 

                     My name is Anthony Panmei. I am 19 years old. I love to sing and dance. I am a student of  

                      science at IMPHAL COLLEGE, IMPHAL, MANIPUR. Currently I am learning computer CCA    

                     course at RGI TRAINING INSTITUTION. 

    

                     The steps involved are: 

1. We click the Microsoft office button. 

2. We select new. The new document dialog box appears. 

3. We select blank document under the blank and recent section. It will be highlighted by 

default. 

4. We click create. A new blank document appears in the word window. 

5. To save the document, we click again the Microsoft office button. 

6. We select save as       word document. The save as dialog box appears. 

1. It is a computer storage that only 

maintains its data while the device 

is power. 

2.  E.g. RAM 

3. Primary memory has limited 

storage capacity and is volatile. 

1. It is a type of computers memory that has 

the capacity to hold saved data even if the 

Power is turned off. 

2. E.g. ROM, hard disk, floppy disk, etc. 

3. Secondary memory provides permanent 

secondary of data and in bulk quantity. 

 



7. We select the location where we want to save the document using the drop-down 

menu. 

8. We enter the file name “yourself” for the document. 

9. We click the save button. 

 Q6 b): Write steps regarding followings 

 Ans:     Steps to change the font style: 

                     1. We select the text we want to modify. 

                     2. Left click the drop-down arrow next to the font style box on the home tab. The font style 

                         drop-down menu appears. 

                     3. We move cursor over the various font styles. A live preview of the font will appear in the 

                          document. 

                     4. Left click the font style we want to use. The font style will change in the document. 

                       Steps to change the font size     

1. We select the text we want to modify. 

2. Left click the drop-down arrows next to the font color box on the home tab. The font 

color menu appears. 

3. We move cursors on various font colors. A live preview of the color will appear in the  

document. 

4. Left click the font color we want to use. The font color will change in the document.  

 

               Steps to highlight the line  

1. We select the line that reads “needs to get IMS`s address” 

2. We click the highlight command and select yellow color in the font group on the  

home tap. 

 

    Q7. Create a file in MS-Word for the following document and save it with file name ‘MS-Word’. 

Describe all steps involved in it. 

Ans: MS Word 

                MS Word is a widely used commercial word processor developed by Microsoft. 

                 MS word is application software, which is capable of  

• creating 

• editing  

• saving 

• printing any type of document  

The steps involved are: 

1. We click the Microsoft office button. 

2. We select new. The new document dialog box appears. 

3. We select blank document under the blank and recent section. It will be highlighted 

by default. 

4. We click create. A new blank document appears in the word window. 

5. We create the given documents from the question. 



6. We select the text “MS word” and change the font size by clicking on the font size 

box on the home tab. 

7. We select the text “MS word” to change the font the font color into red by clicking 

on the font color menu. 

8. We select the text word processor and underline it by clicking the underline 

command in the font group the home tab. 

9. We select the text “MS word” to change the font style into italic by clicking italic 

command. 

10. We select the text we want to format as a list and click on the bullets command on 

the home tab. 

11. We change the font color of the text “creating” and “saving” into blue and red resp.  

by clicking on the font color command, again we select the text “and” and click on 

strikethrough command. 

12. We select the text “printing any type of document” and change the font style into 

bold by clicking on the font style command. 

13. We save the file name as “ms-word” by clicking the Microsoft office button and 

select save as. 

14. We select the location where we want to save the document using drop-down 

menu. 

15. We click the save button. 

    Q8. Create a file in MS-Word for the following document and save it with file name equations. Describe 

all steps involved in it. 

 Ans: Equations   

                X2+Y5=30 

                Z3+Q4=50 

                A2+B8=X2+Y8 

 

 

The steps are: 

• We create the given documents in MS-word. 

• We select the text where we want to format and click on the subscript and 

superscript command on the home tab. 

• We save the file name as “equations” by clicking the Microsoft office button and 

select save as  

• We select the location where we want to save the document using the drop-down 

menu. 

• We click the save button.   

 

Q9. Create a file in MS-Word that convert existing highlight text to table as shown below and save 

it as file name ‘text-to-table’. Describe all steps involved in it. 

Ans: To convert existing text to a table: 

1. We select the existing highlight text that we want to convert. 

2. We select the insert tab. 

3. We click the table command. 

4. We select convert text to table from the menu. A dialog box appears. 

5. We click ok. Then the text appears in a table.              

 



Q10. Create a file in MS-Word to insert a table in the document. Describe all steps involved in it. 

Ans: 

          

          

          

          

          

          

          

 

         the steps are: 

1.We place our insertion point in the document where we want our table to appear. 

2. We select the insert tab. 

3. We click the table command. 

4. We drag our mouse over the diagram squares to select the numbers of columns and rows in the    

      table. 

5 Left click our mouse and the table appears in the document. 

6.We enter the text into the table. 

 

 

Q11. Create a following worksheet in MS-Excel and save it with name ‘book1’. 

 Ans: 

 

 

 

No Name Marks

1 n1 60

2 n2 70

3 n3 80

4 n4 90

5 n5 40

6 n6 50

7 n7 77

8 n8 44

9 n9 88

10 n10 55  
 

 

 

 

 

 

 

 

 

 

 



Q12. Calculate the following things of a range (C2:C11) of data in the worksheet created in question 

no. 10.  

Ans: 

Q12) Ans:

No Name Marks Sum Average Maximum Minimum

1 n1 60 654 65.4 90 40

2 n2 70

3 n3 80

4 n4 90

5 n5 40

6 n6 50

7 n7 77

8 n8 44

9 n9 88

10 n10 55  
 

Q13. (a). Describe various steps involved in the following 

Ans: 

➢ To modify column width of a worksheet: 

I. Select a column or a range of columns. 

II. Select a Home tab and in the Cells group, select Format 

III. Click on Column width and type the width for column. 

IV. Select OK. 

➢ To modify the row height of a worksheet. 

I. Select a row or a range of rows. 

II. Select a Home tab and in the Cells group, select Format. 

III. Click on Row Height and type the height the for row. 

IV. Select OK. 

➢ To delete rows and columns of a worksheet. 

I. Select the cell you want to delete within the column or row. 

II. Select Home tab. And in cells group click on Delete Sheet Column or Row. 

                                                OR 

III. Select the desire row or column. 

Q13. (b). Describe following terms in the worksheet 

Ans: 

➢ Absolute Reference: 

An absolute reference in Excel means there is a fixed point of reference applied to a cell 

or a formula. This is so the return value will always stay the same no matter where the 

cell or formula moves to-within the same sheet or across different sheet. 

This refers to a fixed point of reference is a constant, and involves the use of dollar sign 

$ in the formula ((i.e., everyone is to receive the same bonus payout, so $1500 is a 

constant in this situation). 

 

 

 

➢ Relative Reference: 

         It is the default cell reference in Excel. It is simply the combination of column name and 

row number without dollar ($) sign. When you copy the formula from one cell to another the 

relative cell address changes depending on the relative position of column and row. C1, d2, E4, 

etc. are examples of relative cell references. Relative references are used when we want to 

perform a similar operation on multiple cells and the formula must change according to the 

relative address of column and row. 



 

 

                         This refers to a relative point of reference, is constantly changing and dollar sign ($) 

  is absent in the formula (i.e., when each unit price and quantity are difference variables, 

there’s no constant in the calculation). 

 

➢ Cell Address: 

A cell address is a combination of column letter and a row number that identifies a cell 

on a worksheet. 

For example, A1 refers to the cell at the intersection of column A and row 1; B2 refers to 

the second cell in column B, and so on. 

        When used in formula, cell references help Excel find the values the formula should 

calculate. For instance, 

• To pull the value of A1 to another cell, you use this simple formula: =A1 

• To add up the values in cells A1 and A2, you use this one: =A1+A2  

 

Q14. (a). What tools are available to customize our PowerPoint presentation? 

 Ans. 

          Tools available to customize our PowerPoint presentation are: 

a) Per Spector 

b) Pivot Viewer 

c) Autodesk 3DS Max 

d) Visual Bee PowerPoint Add-in 

e) SmartArt 

f) Animations and Transition 

g) Wordle 

h) CA coo 

i) Oomfo 

j) Clip champ 

                    (b). Write the steps for the following action for creation of power point presentation 

                  Ans.  

➢ To open blank presentation: 

I. Open PowerPoint presentation using ‘Run’ command (window key + R). 

II. Select the ‘Blank Presentation’. It is opened. 

 

 

 

➢ Save the Presentation as Lab 1. pptx.: 

I. Select the ‘File’ on Tab Bar. 

II. Click on ‘Save As’ option. 

III. Click on document/Desktop as your choice. 

IV. Type the name ‘Lab1. pptx’. 

V. Click the ‘Save’ button. 

 

➢ Add a Title to the first slide: the name of your college. 

I. Left click on the ‘Click to Add Title’ section on the first slide. 

II. Type the name of your college. 



➢ Type your first name and last name in the subtitle section: 

i. Left click on the ‘Click to Add Subtitle’ section. 

ii. Type your first name and last name. 

➢ Add a New slide which has a Title and content. 

i. Select the Home tab. 

ii. Click on the dropdown button of the ‘New Slide’ on toolbar. 

iii. Select the slide having ‘Title and Content’. It is added. 

Q15. Write steps for creation of a set of PowerPoint slides that demonstrates your skill to use the tools 

of PowerPoint. It should include the following things 

 Ans. 

➢ Title slide and bullet list: 

i. Open PowerPoint Presentation. 

ii. Select the Home tab. 

iii. Click at the dropdown button on ‘New Slide’ at toolbar. 

iv. Select the slide having Title slide and Bullet list. 

➢ Inserting Excel sheet: 

i. Open the slide where you want to insert the Excel Sheet. 

ii. Select the ‘Insert tab’. And click on ‘Object’ on tool bar. 

iii. Select the ‘Microsoft Excel Worksheet’ object type. 

iv. Click the ‘OK’ button. 

➢ ClipArt and Text: 

i. Select the Insert Tab. 

ii. Select the ‘Pictures’ or ‘Online pictures’ on tool bar. 

iii. Choose the appropriate art for the topic. 

iv. Click on the ‘Insert’ button. 

➢ Slide show effects: 

i. Select ‘Design Tab’ for Themes, Variants and Slide size. 

ii. Select ‘Transition Tab’ for Cut, Fade, Push, Wipe, Split, Reveal, Shape, Flash, etc. 

 

Q16. What is the difference between Machine Language and High-Level Language? 

 Ans. 

 

                                    

                                    

                                        

 

 

 

 

 

Q17. Discuss about difference data types of C programming Language. 

Ans. The different data types of C programming language are:  

 Char: The most basic language type in C. it stores a single character and requires a single bite of 

memory in almost all compilers. 

 

Int:  As the name suggests, an int variable is used to store an integer. 

 

                     Machine language                                                                     

1. A computer programming language 

consisting of binary instructions which a  

computer can respond to directly. 

2. It requires no translator to translate the 

code. It is directly understood by the  

computer. 

3. This language makes fast and efficient use 

of the computer. 

                             High level language 

1. It is a programming language that enables  

development of a programming in a much  

more user-friendly programming context. 

2. It takes additional translation time to  

translate the source code to machine code. 

3. They are programmer friendly. 

 

 



Float: It is used to store decimal numbers. 

 

Double: It is used to store decimal numbers (number with floating point value but its range of values is  

high in comparison to float) 

 

 

Q18. Find the output of the following expressions 

a) X= 20/5*2+30_5    B) Y=30 _ (40/10+6) +10    C) Z=40*2/10_2+10 

 Ans. A) X = 33 

          B) Y = 30 

          C) C = 16 

 

Q19. Describe the syntax of the following statements 

Ans. a) If-else statement: 

If statements can be followed by an optional else block of statements, which executes when 

the Boot can expression is false. 

Syntax 

If (expression) 

{ 

true block of statements; 

} 

else 

{ 

else block of statements; 

} 

b) For loop is similar to while loop. Basic syntax of for loop is as follows: 

         For (expression 1; expression 2; expression 3) 

         { 

Block of statement 

} 

In the above syntax 

Expression1-initializes variables. 

Expression2-conditional expression as long as this condition is true, loop will keep 

  executing. 

Expression3-it is the modifier which will increase or decrease the value of the variable. 

c) While loop. 

 Basic syntax of while loop is as follows 



      While (condition) 

                  Single statement. 

OR while (condition) 

       { 

       Block of statements 

       } 

d) Do-while loop. 

         Do-while loop is just like a while loop except that the text condition is checked at the end of the  

          loop rather than the start. This has the effect that the body of the loop are always executed at  

          least once 

          Basic syntax of do-while loop is as follows 

          Do 

          { 

Single statement  

  Or 

Block of statements 

} while (condition) 

 

Q20. Find the output of the following program segments 

 

 

 

 

 

 

 

 

 

 

  

 

Ans. A) 1 

         B) 2 

         C) b = 100 

a) 

#include <stdio.h> 

int main () 

{ 

  int I; 

     for (i=1; i<2; i++) 

{ 

   printf (“IMS Ghaziabad\n”); 

   } 

} 

b) #include <stdio.h> 

 

int main () 

{ 

   int i = 1; 

   while ( i <= 2) 

     { 

     printf ( “IMS Ghaziabad\n”); 

     i= i +1; 

     } 

} 

 

c) 

#include<stdio.h> 

void main () 

{ 

    int a = 10, b = 100; 

     if (a>b) 

     printf ( “Largest number is %d\n”, a); 

     else 

       printf (“largest number is %d\n”, b); 

} 

 



 


